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Аннотация 

Настоящий документ содержит инструктивный материал по разработке 

ПО под операционную систему реального времени «Стрикс». Он содержит: 

1) требования к ПЭВМ и окружению интегральной среды разработки 

WIDE 2.0; 

2) инструкцию по запуску, настройке и использованию среды 

разработки и интеграции, построенной на базе ИСР WIDE 2.0; 

3) инструкцию по работе с проектами ПО: проектом ФПО, проектом 

интегратора и объединенным проектом ФПО и интегратора; 

4) инструкцию по отладке ПО; 

5) перечень горячих клавиш ИСР WIDE 2.0; 

6) пример создания проекта ФПО. 
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Сокращения, термины и определения 

APEX Интерфейс, определенный спецификацией ARINC 653 

ИСР Интегрированная среда разработки 

Исходный код Текст компьютерной программы на языке Ассемблера и (или) 

языке Си в форме, пригодной для машинного считывания 

ассемблером или компилятором. 

Компилятор Программа, транслирующая операторы исходного кода на языке 

Си в объектный код. 

Компонент Автономная часть, комбинация частей, узлов или модулей, 

выполняющая отдельную функцию системы. 

Модуль Элемент архитектуры ПО, объединяющий некоторое множество 

подпрограмм, типов данных и данных. 

ОС Операционная система 

ОСРВ Операционная система реального времени 

Объектный код Низкоуровневое представление компьютерной программы в форме, 

которая обычно непригодна для непосредственного использования 

в вычислителе, но которая дополнительно к командам процессора 

включает, в том числе, информацию для размещения. 

Отладчик Компьютерная программа, предназначенная для поиска ошибок в 

других программах, ядрах операционных систем и других видах 

кода. 

ПК Персональный компьютер 

ПО Программное обеспечение 

Порт (ARINC 653) Ресурс, с помощью которого происходит отправка и прием 

сообщений по соответствующему каналу между разделами. 

Программное 

обеспечение 

Программы вычислителя и, возможно, связанные с ними 

документация и данные, имеющие отношение к работе 

вычислительной системы. 

Процесс Программный блок, содержащийся внутри раздела и 

выполняющийся параллельно с другими процессами этого же 

раздела. Он включает исполняемую программу, области данных и 

стека, счётчик команд, указатель стека и прочие атрибуты, 

например, приоритет и срок завершения. 

Псевдораздел Устройство, подсистема или программа, не являющиеся 

приложениями, соответствующими ARINC 653, но способные 

обмениваться данными с приложениями, соответствующими 

ARINC 653, через каналы ARINC 653. С точки зрения модуля, в 

качестве псевдораздела может рассматриваться раздел, внешний по 

отношению к модулю. 

Раздел Программа, включая код команд и данные, которая загружается в 

единое адресное пространство вычислителя. 
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СПО Системное программное обеспечение 

СРиИ Среда разработки и интеграции 

Система Совокупность аппаратных и программных компонентов, 

создаваемая для выполнения конкретной функции или набора 

функций. 

Сообщение Пакет данных, передаваемых между разделами или между 

разделами и внешними элементами. 

Стенд Программно-аппаратный комплекс с целевым вычислителем для 

тестирования ПО. Является одним из вариантов используемой 

среды верификации. 

Структура Определенное построение или взаимосвязь частей для образования 

единого целого. 

ФПО Функциональное программное обеспечение 

Ядро Центральная часть операционной системы, обеспечивающая 

программам координированный доступ к ресурсам 

вычислительной системы, таким как процессорное время, память, 

периферийные устройства, файловая система, сетевое 

оборудование. 
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 1 Назначение и условия применения интегрированной среды 

разработки WIDE 2.0 

ИСР WIDE 2.0 предназначена для выполнения следующих основных 

функций: 

1) написание, форматирование, синтаксический анализ, 

документирование исходного кода программ под ОСРВ; 

2) создание проектов, интеграция и отладка ПО под ОСРВ; 

3) конфигурирование ОСРВ. 
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 2 Системные требования интегрированной среды разработки 

WIDE 2.0 

СРиИ функционирует под управлением 64-разрядной операционной 

системы Ubuntu 16.04 и требует установки следующих основных 

компонентов: 

1) ИСР WIDE 2.0 версии 2.0; 

2) виртуальная машина Java (пакет default-jre — версии 1.8); 

3) прокси-сервер последовательных портов Ser2net версии 2.9.1; 

4) tftp-сервер (пакеты openbsd-inetd tftpd tftp) 

5) утилита make версии 4.1, автоматизирующая процесс компиляции 

исходного кода в объектные файлы, и последующей компоновки в 

исполняемые файлы и библиотеки; 

6) набор утилит GNU Core Utilities (coreutils) версии 8.25, содержащий 

основные утилиты, необходимые для UNIX-подобных операционных 

систем. 

Перечень дополнительных инструментов, требуемых для СриИ 

(например, компиляторы и отладчики), приведены в документе «Руководство 

программиста ФПО. Работа с ПО» соответствующего проекта. 

Для установки некоторых средств разработки ПО и программных 

компонентов требуется доступ к сети Интернет. 

 2.1 Установка интегрированной среды разработки WIDE 2.0 

Для установки ИСР WIDE 2.0 требуется: 

1) Распаковать архив udev-rules и запустить скрипт install.sh. 

2) Вставить usb-ключ. 

3) Распоковать WIDE 2.0 и os-target. 

4) Запустить WIDE 2.0. 

5) После запуска появится окно Ошибка лицензии (рисунок 1). 

6) Нажать кнопку «Активировать». 
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7) В появившемся окне выбрать файл лицензии. 

Каждому ключу соответствует свой файл. Имя файла совпадает с 

серийным номером ключа (указан на ключе сбоку). 

 
Рисунок 1 — Окно Ошибка лицензии 

 2.2 Установка виртуальной машины Java 

Для установки виртуальной машины Java необходимо установить пакет 

default-jre, выполнив следующие команды в терминале: 

sudo apt update 

sudo apt install default-jre 

 2.3 Установка Ser2net 

Для установки прокси-сервера последовательных портов Ser2net 

необходимо выполнить следующие команды в терминале: 

sudo apt-get update 

sudo apt-get install ser2net 

 2.4 Установка tftp-сервера 

Для установки tftp-сервера необходимо выполнить следующие команды: 

sudo apt-get update 

sudo apt-get install openbsd-inetd tftpd tftp 

 2.5 Установка утилиты make 

Для установки утилиты make необходимо выполнить следующие 

команды: 

sudo apt-get update 

sudo apt-get install make 

 2.6 Установка набора утилит GNU Core Utilities 

Для установки набора утилит GNU Core Utilities необходимо установить 
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пакет coreutils, выполнив следующие команды в терминале: 

sudo apt update 

sudo apt install coreutils 
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 3 Интегрированная среда разработки WIDE 2.0 

 3.1 Основной функционал интегрированной среды разработки 

WIDE 2.0 

Основные инструментальные средства ИСР WIDE 2.0 включают в себя 

редактор исходного кода, который позволяет создавать и редактировать 

исходный текст программ, средства сборки и отладки, а также плагины для 

работы с системой документирования исходного кода Doxygen. 

 
Рисунок 2 — Главное окно ИСР WIDE 2.0 

Главное меню ИСР WIDE 2.0 включает в себя следующие пункты: 

File − содержит элементы управления проектами и файлами. Позволяет 

создавать новые проекты и файлы с исходным кодом, а также сохранять, 

закрывать, переносить, переименовывать, экспортировать имеющиеся 

структуры проекта и импортировать внешние объекты; 

Edit − содержит стандартные элементы управления текстовой 

информацией: копирование, вставка, удаление, отмена последнего действия, 

возврат после отмены, добавление закладок, а также поиск; 
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Source − содержит элементы управления исходным кодом. Позволяет 

закомментировать или раскомментировать выделенный фрагмент кода 

построчно или одним блоком, форматировать исходный код в соответствии с 

выбранным стилем и устанавливать отступы; 

Refactor − рефакторинг элементов проекта. Помогает производить 

модификации элементов проекта, такие как перемещение и переименование 

без потери связей и целостности программы; 

Navigate − содержит элементы навигации по проекту; 

Search − основное средство поиска файлов, проектов и текста; 

Project − средство управления проектами. Содержит команды для 

компиляции и сборки программ; 

Run − управление запуском приложения. Позволяет запустить 

программу в различных режимах; 

Window − управление окнами и компоновками, переключение между 

компоновками, вызов требуемых окон; 

Help − вызов справки. Для того, чтобы посмотреть справочные и 

инструктивные материалы по созданию и развитию проектов ОСРВ, 

необходимо в главном меню ИСР WIDE 2.0 выполнить «Help → Help Contens» 

или нажать комбинацию клавиш «Ctrl+F1», и выбрать пункт «ОСРВ», как 

показано на рисунке 3. 

Наиболее часто используемые команды продублированы в виде кнопок 

на панели инструментов главного окна ИСР WIDE 2.0. При наведении 

указателя мыши на кнопку на панели инструментов появится всплывающая 

подсказка с названием действия, которое будет выполнено. Если выполнение 

действия невозможно, кнопка будет неактивной. 

Перечень горячих клавиш и их назначение приведен в Приложении А 

настоящего документа. 
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Рисунок 3 — Окно «Help» ИСР WIDE 2.0 

Редакторы ИСР WIDE 2.0 представляют собой программные средства, 

позволяющие осуществлять операции с файлами (создавать, открывать, 

редактировать, сохранять и др.). В ИСР WIDE 2.0 представлены следующие 

редакторы: 

1) C/C++ Editor – текстовый редактор, предназначенный для ввода и 

редактирования исходного кода программы на языке Си; 

2) ArincEditor – визуальный редактор, предназначенный для подготовки 

конфигурационного файла ARINC 653 и предоставляющий следующий 

функционал: 

 возможность редактирования конфигурационного файла 

ARINC 653 в текстовом режиме; 

 возможность проверки синтаксиса и семантики 

конфигурационного файла ARINC 653. 

 

3) Integrator Editor – визуальный редактор, предназначенный для 

настройки параметров сборки проекта Интегратора; 
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4) FPO Editor – визуальный редактор, предназначенный для настройки 

параметров сборки проекта ФПО. 

В редакторе может быть отображено содержимое только одного файла 

проекта. Если открыто более одного файла, то в верхней части редактора 

появляется строка вкладок, с помощью которой можно быстро переключаться 

между различными файлами, выбирая курсором мыши необходимую вкладку. 

Функциональные окна ИСР WIDE 2.0 являются дополнениями к 

редакторам, в которых выводится информация сопроводительного или 

дополнительного характера о файле, находящемся в редакторе. 

ИСР WIDE 2.0 предоставляет различные наборы функциональных 

окон − компоновки. Под компоновкой понимается набор функциональных 

окон, расположенных в требуемом порядке. В каждой компоновке имеется 

свой набор инструментов, но некоторые компоновки могут иметь общие 

наборы инструментов. В определенный момент времени активной может быть 

только одна компоновка. В ИСР WIDE 2.0 представлены следующие основные 

компоновки: 

1) компоновка «С/С++» – набор инструментов для подготовки программ 

на языке Си; 

2) компоновка «ARINC 653» – набор инструментов для подготовки 

конфигурационного файла ARINC 653; 

3) компоновка «Debug» – набор инструментов для отладки программ. 

Наиболее часто используемые функциональные окна для различных 

компоновок приведены в таблице 1. Описание функциональных окон 

приведено в таблице 2. 

Таблица 1 — Компоновки функциональных окон ИСР WIDE 2.0 

Компоновка Функциональные окна и редакторы 

С/С++ C/C++ Editor, Project Explorer, Outline, Problems, Console 
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Компоновка Функциональные окна и редакторы 

ARINC 653 ARINC Editor, BootEditor, Project Explorer, Outline, Problems, Console 

Debug Breakpoints, Debug, Variables, Expressions, Outline, Console 

Таблица 2 — Функциональные окна ИСР WIDE 2.0 

Функциональное 

окно 
Описание 

С Editor 
Текстовый редактор, предназначенный для ввода и редактирования 

исходного кода программы на языке Си 

IntegratorEditor 
Визуальный редактор, предназначенный для редактирования 

параметров сборки проекта Интегратора 

FPO Editor 
Визуальный редактор, предназначенный для редактирования 

параметров сборки проектов ФПО 

Arinc Editor 
Визуальный редактор, предназначенный для подготовки 

конфигурационного файла ОСРВ config.xml 

BootEditor 
Визуальный редактор, предназначенный для подготовки файла с 

параметрами загрузочного образа boot.xml 

Project Explorer 

Менеджер проектов, который предназначен для отображения 

представления проекта и представляет собой иерархическую 

структуру каталогов и файлов, входящих в проект 

Outline Отображает структуру файла, открытого в редакторе 

Problems Отображает список ошибок и предупреждений 

Console Системная консоль, в которую происходит вывод данных программы 

Breakpoints 
Отображает информацию об установленных точках останова 

программы 

Debug Предоставляет информацию о процессах запущенной программы 

Variables 
Предоставляет информацию о переменных в выбранном стековом 

фрейме 
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Функциональное 

окно 
Описание 

Expressions 
Оценивает переменную или выражение в контексте процесса отладки 

и позволяет изменять их значения 

 3.2 Запуск интегрированной среды разработки WIDE 2.0 

При первом запуске ИСР WIDE 2.0 откроется окно, в котором 

необходимо выбрать путь к каталогу рабочего пространства − места, где будут 

храниться локальные копии файлов, как показано на рисунке 4, и нажать 

кнопку «OK». 

Установка опции «Use this as the default and do not ask again» позволит 

использовать указанное рабочее пространство по умолчанию и данное окно 

больше появляться не будет. 

 
Рисунок 4 — Диалоговое окно «Eclipse Launcher» ИСР WIDE 2.0 

Для того, чтобы изменить рабочее пространство, необходимо в главном 

меню ИСР WIDE 2.0 выбрать «File→Switch Workspace→Other». В 

открывшемся окне, как показано на рисунке 5, в поле «Recent Workspaces» 

перечислены ранее использованные рабочие пространства. Для того, чтобы 

скопировать текущие настройки рабочего пространства, необходимо отметить 

пункты «Workbench Layout» и «Working Sets» в поле «Copy Settings», после 

чего нажать кнопку «ОК». 
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После выполнения действий, описанных выше, появится главное окно 

ИСР WIDE 2.0, которое включает в себя главное меню, панель инструментов, 

набор компоновок, расположенных справа от панели инструментов, и набор 

функциональных окон, как показано на рисунке 2. 

 
Рисунок 5 — Диалоговое окно «Eclipse Launcher» ИСР WIDE 2.0 

 3.3 Настройка интегрированной среды разработки WIDE 2.0 

 3.3.1 Настройка многооконного интерфейса 

ИСР WIDE 2.0 обеспечивает возможность гибкого переноса положения 

функциональных окон и изменения их размера. Для отображения 

необходимого окна в главном меню ИСР WIDE 2.0 выбрать «Window→Show 

View→Other...». В открывшемся диалоговом окне «Show View» выбрать окно, 

которое необходимо отобразить, как показано на рисунке 6, и нажать кнопку 

«OK». 

Для того, чтобы открыть компоновку, в главном меню ИСР WIDE 2.0 

выбрать «Window→Perspective→Open Perspective→Other» и в открывшемся 

диалоговом окне «Open Perspective» отметить необходимую компоновку, 

после чего нажать кнопку «OK». Для быстрого переключения между 

компоновками необходимо нажать на соответствующую пиктограмму на 

панели переключения компоновок, расположенной в правом верхнем углу 
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главного окна ИСР WIDE 2.0, как показано на рисунке 7. 

 
Рисунок 6 — Диалоговое окно «Show View» ИСР WIDE 2.0 

 
Рисунок 7 — Панель переключения компоновок ИСР WIDE 2.0 

 3.3.2 Настройка подсветки синтаксиса 

ИСР WIDE 2.0 обеспечивает возможность настройки подсветки 

синтаксиса языка Си и Ада. Для настройки подсветки синтаксиса языка Си 

требуется в главном меню ИСР WIDE 2.0 выбрать 

«Window→Preferences→C/C++→ Editor→Syntax Coloring», как показано на 

рисунке 8. 
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Рисунок 8 — Диалоговое окно «Preferences» ИСР WIDE 2.0 

 3.3.3 Настройка параметров анализа исходного кода на предмет 

синтаксических ошибок 

ИСР WIDE 2.0 обеспечивает возможность первичного анализа 

исходного кода (только для языка Си) на предмет синтаксических ошибок. 
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Настройка осуществляется в ИСР WIDE 2.0 в окне 

«Window→Preferences→C/C++→ Code Analysis», как показано на рисунке 9. 

 
Рисунок 9 — Диалоговое окно «Preferences» ИСР WIDE 2.0 

 3.3.4 Настройки автоформатирования исходного кода на языке Си 

Для того, чтобы открыть настройки автоформатирования исходного 

кода на языке Си, необходимо в главном меню ИСР WIDE 2.0 выбрать 

«Window→Preferences→С/С++→Code Style→Formatter», после чего 

откроется окно, как показано на рисунке 10. 

В поле «Active profile» имеется возможность выбрать один из 

предустановленных стилей: K&R, BSD/Allman, GNU и Whitesmiths. 
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Рисунок 10 — Диалоговое окно «Preferences» ИСР WIDE 2.0 

Для того, чтобы создать пользовательский профиль настроек 

автоформатирования, необходимо нажать на кнопку «New». В появившемся 

окне «New Code Formatter Profile», как показано на рисунке 11, в поле «Profile 

name» ввести имя профиля, а в поле «Initialize settings with the following profile» 

необходимо выбрать один из существующих профилей, из которого будут 

скопированы настройки для создаваемого профиля, и нажать кнопку «ОК». 
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Рисунок 11 — Диалоговое окно «New Code Formatter Profile» ИСР WIDE 2.0 

Если установлен флаг «Open the edit dialog now», то после создание 

профиля откроется окно редактирования профиля «Profile», как показано на 

рисунке 12. Для того, чтобы открыть окно редактирования для уже созданного 

профиля, необходимо в окне «Formatter», показанном на рисунке 10, нажать 

на кнопку «Edit». 

В окне «Profile» находятся следующие вкладки: 

 «Indentation» содержит параметры управления отступами; 

 «Braces» содержит параметры управления положения фигурных 

скобок; 

 «White Space» содержит параметры управления пробелами в 

объявлениях переменных, управляющих конструкциях и т. д.; 

 «New Lines» содержит параметры управления стилем в конструкторах 

классов (только для С++); 

 «Control Statements» содержит параметры управления стилем в 

управляющих конструкциях; 

 «Line Wrapping» содержит параметры управления переносами строк; 

 «Comments» содержит параметры управления комментариями. 
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Рисунок 12 — Диалоговое окно «Profile» ИСР WIDE 2.0 

Для того, чтобы отформатировать исходный код в редакторе 

«C/C++ Editor», необходимо в главном меню ИСР WIDE 2.0 выбрать 

«Source→Format». Эта команда применяет выбранные опции форматирования 

исходного кода, включая отступы. 

Для того, чтобы установить отступы, необходимо в главном меню 

ИСР WIDE 2.0 выбрать «Source→Correct Indentation». 

Для того, чтобы отформатировать фрагмент исходного кода, 

необходимо выделить нужные строки в редакторе перед вызовом команды 

«Format» или «Correct Indentation». 

 3.3.5 Установка и настройка средства документирования 

исходного кода Doxygen 

ИСР WIDE 2.0 предоставляет возможность создания документации на 

основе набора исходных текстов при помощи системы Doxygen. Для 

установки необходимо подключение интернета к компьютеру, на котором 

установлена ИСР. Для установки средства документирования необходимо 
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установить плагин Eclox, выполнив следующие действия. 

1) В главном меню ИСР WIDE 2.0 выбрать «Help→Eclipse Marketplace», 

в открывшемся окне «Eclipse Marketplace» в поле «Find:» ввести «Eclox», как 

показано на рисунке 13, и нажать клавишу «Enter». 

 
Рисунок 13 — Диалоговое окно «Eclipse Marketplace» ИСР WIDE 2.0 

2) В окне «Eclipse Marketplace» появится информация о найденном 

плагине, как показано на рисунке 14, после чего нажать кнопки 
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«Install→Confirm→Finish», дождаться завершения установки и перезапустить 

ИСР WIDE 2.0. 

 
Рисунок 14 — Диалоговое окно «Eclipse Marketplace» ИСР WIDE 2.0 

Для настройки средства документирования необходимо выполнить 

следующие действия. 

1) Создать файл конфигурации «DoxyFile», для этого в окне 

«Project Explorer» щелкнуть правой кнопкой мыши и в появившемся 
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контекстном меню выбрать «New→Other». 

2) В открывшемся окне «New» выбрать «Other→Doxyfile», как показано 

на рисунке 15, и нажать кнопку «Next». 

 
Рисунок 15 — Диалоговое окно «New» ИСР WIDE 2.0 

3) В открывшемся окне указать путь, по которому будет сохранен файл 

конфигурации «DoxyFile», и задать ему имя, как показано на рисунке 16, после 

чего нажать кнопку «Finish». 

4) Открыть создавшийся файл конфигурации «DoxyFile», щелкнув по 

нему два раза левой кнопкой мыши в окне «Project Explorer». 

5) В открывшемся файле конфигурации «DoxyFile» содержится два 

окна − «Basic» и «Advanced», в которых задаются параметры проекта, как 

показано на рисунке 17. 
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Рисунок 16 — Диалоговое окно «New Doxygen Configuration» ИСР WIDE 2.0 

 
Рисунок 17 — Интерфейс файла конфигурации в ИСР WIDE 2.0 

6) В окне «Basic» в поле «Input directory» необходимо нажать кнопку 

«Add», в открывшемся окне нажать кнопку «Browse Directory» и выбрать 

каталог с файлами исходного кода. Для того, чтобы к указанному каталогу с 

файлами исходного кода добавились подкаталоги, необходимо установить 

флаг «Scan recursively». 

7) Для изменения формата создаваемой документации необходимо в 
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окне «Basic» в поле «Output Format» выбрать требуемый формат вывода 

документации из приведенных: 

 HTML – стандартизированный язык разметки документов; 

 LaTeX – система компьютерной верстки TeX; 

 Man – формат, предназначенный для форматирования и вывода 

справочных страниц; 

 RTF – проприетарный межплатформенный формат хранения 

размеченных текстовых документов; 

 XML – расширяемый язык разметки. 

8) В окне «Basic» в поле «Output directory» необходимо нажать на кнопку 

«Browse» и выбрать каталог, в который будут сохранены сгенерированные 

файлы. 

9) Для того, чтобы плагин корректно работал с русским языком, в окне 

«Advanced» в параметре «Output Language» изменить значение с «English» на 

«Russian». 

10) После того, как файл конфигурации «DoxyFile» настроен, его 

необходимо запустить на исполнение. Для этого требуется щелкнуть правой 

кнопкой мыши по файлу конфигурации «DoxyFile» в окне «Project Explorer», 

как показано на рисунке 18, и выбрать пункт контекстного меню 

«Build Documentation». Сгенерированные файлы будут сохранены в каталог, 

который был указан как выходной в параметрах проекта. 
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Рисунок 18 — Окно «Project Explorer» ИСР WIDE 2.0 

 3.3.6 Настройка кодировки редактора исходного кода 

В ИСР WIDE 2.0 по умолчанию используется кодировка UTF-8. Для ее 

изменения необходимо в главном меню ИСР WIDE 2.0 выбрать 

«Window→Preferences→General→Workspace» и в поле «Text file encoding» в 

выпадающем списке пункта «Other:» выбрать необходимую кодировку, как 

показано на рисунке 19. 
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Рисунок 19 — Диалоговое окно «Preferences» ИСР WIDE 2.0 
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 4 Работа с проектами ПО 

В ИСР WIDE 2.0 поддерживается три типа проекта: проект ФПО, проект 

Интегратора и объединенный проект. 

Проект ФПО представляет собой раздел ФПО, библиотеку или сервер и 

содержит исходный код данного раздела (библиотеки, сервера). 

Проект Интегратора представляет собой конфигурацию загружаемого 

образа. Проект Интегратора включает в себя конфигурацию и параметры 

разделов ФПО, конфигурацию и состав загружаемого образа. В проекте 

Интегратора также указываются входящие в загружаемый образ проекты 

ФПО, либо указывается местоположение уже собранных программ в 

бинарном виде. В проекте Интегратора отсутствуют файлы с исходным кодом. 

Проект Интегратора может быть только один в рабочем пространстве 

workspace. 

Процесс интеграции ФПО и ОСРВ можно условно разделить на два 

уровня: 

 уровень разработчика ФПО; 

 уровень Интегратора. 

Уровень разработчика ФПО включает в себя подготовку исходного кода 

программ. Уровень Интегратора включает в себя следующие этапы: 

 подготовка конфигурационного файла ARINC 653 (config.xml); 

 подготовка файла с параметрами загрузочного образа (boot.xml); 

 импорт проектов ФПО с исходным кодом; 

 сборка загружаемого образа. 

Если проект ФПО соответствует уровню разработчика ФПО, то проект 

Интегратора соответствует уровню Интегратора. 

Объединенный проект представляет собой объединение проекта 

Интегратора и проектов ФПО – здесь разделы ФПО располагаются внутри 

каталога src. Таким образом, объединенный проект содержит как 
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конфигурацию, так и исходный код разделов ФПО. Объединенных проектов 

может быть несколько внутри рабочего пространства workspace. 

 4.1 Проект ФПО 

 4.1.1 Структура проекта ФПО 

Проект ФПО может быть реализован в виде раздела, библиотеки или 

сервера. Независимо от вида, проект ФПО представляет собой каталог со 

следующим содержимым: 

 make-файл; 

 файлы с исходным кодом. 

Пример содержимого проекта в окне «Project Explorer» ИСР WIDE 2.0 

показан на рисунке 20. 

 
Рисунок 20 — Отображение примера проекта ФПО в окне «Project Explorer» 

ИСР WIDE 2.0 

 4.1.1.1 Make-файл проекта ФПО 

Make-файл проекта ФПО создается автоматически при создании 

проекта. Пример листинга make-файла приведен на рисунке 21. 
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Рисунок 21 — Пример листинга make-файла проекта ФПО 

Make-файл проекта ФПО содержит следующие параметры, 

необходимые для сборки проекта: 

 OS_TARGET – путь до поставочного комплекта ОСРВ; 

 TARGET_NAME – соответствует названию проекта ФПО; 

 TARGET_TYPE – тип программы: раздел (APEX), библиотека (LIB) 

или сервер (SERVER); 

 LIBS – библиотеки, необходимые для сборки проекта ФПО; 

 ОBJS – файлы, участвующие в сборке. Если ни один файл не указан, 

то в сборке участвуют все файлы с исходным кодом, находящиеся в 

данном каталоге; 

 XCFLAGS («ADAFLAGS» для ФПО, разрабатываемого на языке Ада) 

– дополнительные флаги сборки для компилятора; 

 INCLUDE_HEADERS – заголовочные файлы библиотеки (только для 

библиотек); 

 INCLUDE_TARGET – указывает директорию, в которую будут 

скопированы заголовочные файлы при экспорте библиотеки (только для 

библиотек). 

Make-файл проекта создается и редактируется средствами ИСР WIDE 

2.0. Не рекомендуется изменять make-файл вручную. 
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 4.1.1.2 Каталог Includes 

Каталог Includes в отображении проекта является виртуальным (не 

существует в файловой системе). 

Виртуальный каталог Includes не влияет на сборку проекта, он 

предназначен для более удобного создания и редактирования исходного кода. 

Для того чтобы редактировать пути в виртуальном каталоге Includes, 

необходимо выполнить следующие действия: 

1) в окне «Project Explorer» щелкнуть правой кнопкой мыши по проекту 

и, в появившемся контекстном меню, выбрать «Properties»; 

2) в открывшемся диалоговом окне, выбрать пункт «Paths and Symbols» 

в категории «С/С++ General», после чего откроется диалоговое окно, как 

показано на рисунке 22; 

 
Рисунок 22 — Диалоговое окно «Properties» ИСР WIDE 2.0 

3) на вкладке «Includes» выбрать в столбце «Languages» язык «GNU C». 

В правой части диалогового окна содержатся кнопки, которые выполняют 

следующий функционал: 

 «Add» – добавить новый путь в каталог Includes; 



СПО. Руководство программиста ФПО. ИСР WIDE 2.0 

ВАШП.501120.101 strix-guide:WIDE@v1.0.1 Стр. 36 из 113 
 

 «Edit» – редактировать существующий путь; 

 «Delete» – удалить существующий путь. 

 4.1.2 Создание проекта ФПО 

Для создания проекта ФПО требуется выполнить следующие действия: 

1) в главном меню ИСР WIDE 2.0 выбрать «File→New→Project»; 

2) в появившемся диалоговом окне «New», в категории «ОСРВ», как 

показано на рисунке 23, выбрать значение «Раздел», «Библиотека» или 

«Сервер» в зависимости от типа создаваемого проекта и нажать кнопку 

«Next»; 

 
Рисунок 23 — Диалоговое окно «New» ИСР WIDE 2.0 

3) в открывшемся окне «Новый раздел ОСРВ», как показано на 

рисунке 24, в поле «Project name» указать имя создаваемого проекта. В поле 

«OS_TARGET» указать путь до поставочного комплекта ОСРВ. В поле 

«Библиотеки» могут быть указаны библиотеки, необходимые для сборки 

проекта. В поле «Флаги компиляции» могут быть указаны флаги компилятора. 
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Рисунок 24 — Диалоговое окно «Новый раздел ОСРВ» ИСР WIDE 2.0 

 4.1.3 Импорт проекта ФПО 

Для того чтобы импортировать готовый проект ФПО, необходимо 

выполнить следующие действия: 

1) щелкнуть правой кнопкой мыши в окне «Project Explorer» ИСР WIDE 

2.0 и, в появившемся контекстном меню, выбрать «Import»; 

2) в открывшемся диалоговом окне, в категории «ОСРВ» выбрать в 

зависимости от типа импортируемого проекта значение «Раздел», 

«Библиотека» или «Сервер», как показано на рисунке 25, и нажать кнопку 

«Next»; 
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Рисунок 25 — Диалоговое окно «Import» ИСР WIDE 2.0 

3) в открывшемся диалоговом окне «Импорт проекта Partition», как 

показано на рисунке 26, в поле «Project location:» нажать кнопку «Browse...» и 

выбрать путь до импортируемого проекта. При необходимости изменить путь 

до поставочного комплекта ОСРВ, для этого нажать кнопку «Browse...» в поле 

«OS_TARGET:» и выбрать путь, после чего нажать кнопку «Finish». 

Если нет необходимости, чтобы файлы проекта были скопированы в 

рабочее пространство ИСР WIDE 2.0 (workspace), то необходимо убрать флаг 

«Copy into workspace». В этом случае ИСР WIDE 2.0 будет работать с файлами 

проекта, расположенными в импортируемом каталоге (не рекомендуется). 
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Рисунок 26 — Диалоговое окно «Импорт проекта Partition» ИСР WIDE 2.0 

Для того чтобы скопировать проект, необходимо выполнить следующие 

действия: 

1) щелкнуть правой кнопкой мыши по проекту, который необходимо 

скопировать, и, в открывшемся контекстном меню, выбрать команду «copy»; 

2) щелкнуть правой кнопкой мыши по пустому месту в окне «Project 

Explorer» и, в появившемся контекстном меню, выбрать команду «paste»; 

3) в открывшемся окне, ввести имя проекта. 

Для переименования проекта необходимо щелкнуть правой кнопкой 

мыши по проекту в окне «Project Explorer» и, в появившемся контекстном 

меню, выбрать команду «Rename». В открывшемся окне, ввести новое имя 

проекта. 

 4.1.4 Параметры и запуск сборки проекта ФПО 

ИСР WIDE 2.0 для сборки проектов ФПО использует утилиту make. 

Параметры сборки, которые передаются утилите make, указаны в make-файле 
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проекта ФПО. Для изменения параметров сборки необходимо открыть файл 

Makefile. Редактирование файла осуществляется в редакторе «FpoEditor», как 

показано на рисунке 27. 

 
Рисунок 27 — Окно редактора «Fpo Editor» ИСР WIDE 2.0 

В поле OS_TARGET указывается путь до поставочного комплекта 

ОСРВ. 

В поле «Libraries» добавляются или удаляются библиотеки, 

необходимые для сборки программы, входящей в проект. 

В поле «Исходный код» указываются файлы, участвующие в сборке. 

Если ни один файл не указан, то в сборке участвуют все файлы с исходным 

кодом, находящиеся в данном каталоге. Файлы, имена которых начинаются с 

символа «!», в сборке не участвуют. 

Для того чтобы исключить файл из сборки, необходимо в окне «Project 

Explorer» щелкнуть правой кнопкой мыши по выбранному файлу и в 

появившемся контекстном меню выбрать «Build Path→Exclude», как показано 

на рисунке 28. 
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Рисунок 28 — Вызов команды «Exclude» из контекстного меню ИСР WIDE 

2.0 

Для включения файла обратно в сборку программы или библиотеки 

необходимо выбрать «Build Path→Include». В поле «Флаги компилятора» 

задается значение дополнительных флагов сборки для компилятора. 

Для проекта библиотеки в редакторе «Fpo Editor» доступна вкладка 

«Headers», на которой указываются заголовочные файлы библиотеки, которые 

должны быть видимы для разделов, серверов и других библиотек, как показано 

на рисунке 29. Если заголовочный файл не указан, то раздел, которому для 

сборки необходима данная библиотека, не сможет использовать этот файл. В 

поле «INCLUDE_TARGET» указывается путь относительно директории 

«include» в каталоге сборки, где будут расположены заголовочные файлы. 
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Рисунок 29 — Окно редактора «Fpo Editor» ИСР WIDE 2.0 

Редактирование make-файла допускается через свойства проекта ФПО. 

Для того чтобы открыть свойства проекта ФПО, необходимо в окне «Project 

Explorer» щелкнуть правой кнопкой мыши по проекту, в открывшемся 

контекстном меню, выбрать «Properties→Проект ФПО», как показано на 

рисунке 30. 

 
Рисунок 30 — Диалоговое окно «Properties» ИСР WIDE 2.0 

По умолчанию сборка осуществляется в каталог build, расположенный в 



СПО. Руководство программиста ФПО. ИСР WIDE 2.0 

ВАШП.501120.101 strix-guide:WIDE@v1.0.1 Стр. 43 из 113 
 

проекте ФПО. Если в свойствах проекта ФПО в поле «Build in» выбрать 

значение «Workspace», то сборка будет осуществляться в каталог build, 

который расположен в рабочем пространстве workspace. Каталог build, 

расположенный в рабочем пространстве workspace, является общим для всех 

проектов. 

Для запуска сборки проекта в окне «Project Explorer» необходимо 

щелкнуть правой кнопкой мыши по проекту и, в появившемся контекстном 

меню, выбрать «Build Project» (конфигурация сборки по умолчанию – Default). 

Протокол сборки выводится в окно «Console», как показано на 

рисунке 31. 

 
Рисунок 31 — Окно «Console» ИСР WIDE 2.0 

В результате успешной сборки раздела или сервера создается файл с 

расширением *.elf, в случае сборки библиотеки создается файл с расширением 

*.a, и каталог include с заголовочными файлами библиотеки. 

Если в процессе сборки проекта была обнаружена синтаксическая 

ошибка в исходном коде программы, то сообщение о типе ошибки и ее 

предполагаемом местонахождении будет выведено в протокол сборки в окно 

«Console», как показано на рисунке 32. 

 
Рисунок 32 — Окно «Console» ИСР WIDE 2.0 
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Библиотеку и сервер можно экспортировать в поставочный комплект 

ОСРВ. Для этого необходимо щелкнуть правой кнопкой мыши по проекту и, 

в появившемся контекстном меню, выбрать Build Configurations → 

Set Active → «Экспорт» в os-target, как показано на рисунке 33. В результате 

экспорта библиотеки (сервера) в поставочный комплект ОСРВ, собранная 

библиотека (сервер) будет скопирована в поставочный комплект ОСРВ и 

будет доступна наряду с другими библиотеками и серверами, входящими в 

поставочный комплект ОСРВ. 

 
Рисунок 33 — Вызов команды «Экспорт в os-target» из контекстного меню 

ИСР WIDE 2.0 

Выбор конфигурации сборки и запуск сборки доступен на панели 

инструментов. Для запуска последней конфигурации сборки, необходимо 

нажать на кнопку «build» на панели инструментов. Для выбора конфигурации 

сборки и ее запуска необходимо выбрать требуемую конфигурацию сборки в 

меню рядом с кнопкой «build», как показано на рисунке 34. 

 
Рисунок 34 — Кнопка «Build» на панели инструментов ИСР WIDE 2.0 
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 4.2 Проект интегратора 

 4.2.1 Структура проекта интегратора 

Проект Интегратора представляет собой каталог со следующим 

содержимым: 

 make-файлы проекта – makefile и appset.mk; 

 файл со списком каталогов с исходным кодом, участвующих в 

сборке – prjdeps.in; 

 конфигурационный файл ARINC 653 – config.xml; 

 файл с параметрами загрузочного образа – boot.xml. 

Пример содержимого проекта в окне «Project Explorer» показан на 

рисунке 35. 

Проект Интегратора может быть только один в текущем рабочем 

пространстве workspace. Make-файл проекта Makefile, расположенный в корне 

каталога проекта интегратора, содержит следующие параметры, необходимые 

для сборки проекта: 

 SRC_PATH – путь до каталога с исходными файлами проекта; 

 IMAGE_PATH – путь до каталога с файлами config.xml и boot.xml; 

 BOOT_IMAGE – имя загрузочного образа, который будет получен в 

результате сборки проекта; 

 BUILDDIR – путь до каталога, в который осуществляется сборка 

проекта; 

 ARINC_CFG – путь до конфигурационного файла ARINC 653; 

 BOOT_CFG – путь до файла с параметрами загрузочного образа; 

 ADDITIONAL_ELFSEARCH_PATHS – содержит пути до каталогов с 

бинарными файлами уже собранных разделов в формате *.elf. Каталоги 

с бинарными файлами могут располагаться вне рабочего пространства 

workspace. 
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Пример листинга make-файла проекта интегратора приведен на 

рисунке 36. 

 
Рисунок 35 — Отображение примера проекта интегратора в окне «Project 

Explorer» ИСР WIDE 2.0 

 
Рисунок 36 — Пример листинга make-файла проекта Интегратора 

Make-файл appset.mk содержит цели «all» (сборка исходного кода − цель 

по умолчанию) и «clean» (удаление всех созданных в результате сборки 

файлов). Он формируется при создании проекта и не должен быть изменен. 

Файл prjdeps.in содержит полные пути до каталогов с исходным кодом 

разделов (библиотек, серверов), участвующих в сборке. Каталоги с исходным 

кодом должны соответствовать проектам ФПО и находиться в рабочем 

пространстве workspace. 

Все make-файлы проекта и файл prjdeps.in создаются и редактируются 

автоматически средствами ИСР WIDE 2.0. Не рекомендуется изменять 

make-файлы вручную. По умолчанию make-файлы проекта не отображаются в 
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окне «Project Explorer». Для просмотра файлов в окне редактора необходимо 

нажать кнопку «Show makefiles» на панели инструментов главного окна ИСР 

WIDE 2.0, как показано на рисунке 37. 

 
Рисунок 37 — Кнопка «Show makefiles» на панели инструментов ИСР WIDE 

2.0 

Для того чтобы отключить автоматическое редактирование make-

файлов, необходимо нажать кнопку «Autoformat makefiles» на панели 

инструментов, как показано на рисунке 38. 

 
Рисунок 38 — Кнопка «Autoformat makefiles» на панели инструментов 

ИСР WIDE 2.0 

 4.2.2 Создание проекта интегратора 

Для создания проекта ФПО требуется выполнить следующие действия: 

1) в главном меню ИСР WIDE 2.0 выбрать «File→New→Project»; 

2) в появившемся диалоговом окне «New», в категории «ОСРВ» выбрать 

подпункт «Интегратор», как показано на рисунке 39, и нажать кнопку «Next»; 
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Рисунок 39 — Диалоговое окно «New» ИСР WIDE 2.0 

3) в открывшемся окне «Новый проект ОСРВ», как показано на 

рисунке 40, в поле «Project name» указать имя создаваемого проекта. В поле 

«OS_TARGET» указать путь до поставочного комплекта ОСРВ и нажать 

кнопку «Finish». 
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Рисунок 40 — Диалоговое окна «Новый проект ОСРВ» ИСР WIDE 2.0 

 4.2.3 Импорт проекта интегратора 

Для того, чтобы импортировать готовый проект Интегратора, 

необходимо выполнить следующие действия: 

1) щелкнуть правой кнопкой мыши в окне «Project Explorer» ИСР WIDE 

2.0 и, в появившемся контекстном меню, выбрать «Import»; 

2) в открывшемся диалоговом окне, в категории «ОСРВ» выбрать 

«Интегратор», как показано на рисунке 41, и нажать кнопку «Next»; 

3) в открывшемся диалоговом окне «Импорт проекта ОСРВ», как 

показано на рисунке 42 в поле «Project location:» нажать кнопку «Browse...» и 

выбрать путь до импортируемого проекта. При необходимости изменить путь 

до поставочного комплекта ОСРВ, для этого нажать кнопку «Browse...» в поле 

«OS_TARGET:» и выбрать путь, после чего нажать кнопку «Next»; 
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Рисунок 41 — Диалогового окна «Import» ИСР WIDE 2.0 

 
Рисунок 42 — Диалоговое окно «Import» ИСР WIDE 2.0 

4) на следующей странице диалогового окна «Импорт проекта ОСРВ» 
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необходимо указать расположение проектов ФПО, входящих в 

импортируемый проект Интегратора, как показано на рисунке 43, и нажать 

кнопку «Finish». Проект Интегратора будет импортирован в рабочее 

пространство workspace вместе со всеми указанными проектами ФПО. 

 
Рисунок 43 — Диалоговое окно «Import» ИСР WIDE 2.0 

 4.2.4 Подготовка файла с параметрами загрузочного образа 

 4.2.4.1 Создание файла с параметрами загрузочного образа 

Для создания файла с параметрами загрузочного образа в уже созданном 

проекте необходимо щелкнуть правой кнопкой мыши по пустому месту в окне 

«Project Explorer» и, в появившемся контекстном меню, выбрать 

«New→boot.xml», как показано на рисунке 44. 
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Рисунок 44 — Контекстное меню «New→boot.xml» ИСР WIDE 2.0 

 4.2.4.2 Редактирование файла с параметрами загрузочного образа 

Для редактирования файла с параметрами загрузочного образа 

необходимо открыть файл boot.xml. Редактирование файла осуществляется в 

редакторе «BootEditor», который содержит страницы «Ядро», 

«Таблица процессов» и «boot.xml». 

Страница «Ядро» позволяет задать значения параметров конфигурации 

ядра ОСРВ, как показано на рисунке 45. 

 
Рисунок 45 — Страница «Ядро» редактора «BootEditor»  

Страница «Таблица процессов» позволяет редактировать таблицу 

процессов загружаемого образа. Страница «Таблица процессов» разделена на 
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две части, как показано на рисунке 46. 

 
Рисунок 46 — Страница «Таблица процессов» редактора «BootEditor»  

В окне «Таблица процессов» слева расположено дерево с элементами 

Server и Partition, справа отображаются поля со значениями атрибутов 

выбранного элемента. Атрибуты, обязательные для заполнения, помечены 

символом «*». Если навести указатель мыши на название атрибута, то 

появится описание значения типа этого атрибута, как показано на рисунке 47. 

 
Рисунок 47 — Окно редактирования атрибутов в редакторе «BootEditor» 

Для отображения дополнительных параметров сервера необходимо 

нажать на кнопку «Show Details» в правом верхнем углу на странице «Таблица 

процессов», как показано на рисунке 48. 
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Рисунок 48 — Окно редактирования атрибутов в редакторе «BootEditor» 

При переходе на другую страницу редактора, а также при сохранении, 

файл с параметрами загрузочного образа автоматически проверяется на 

предмет синтаксических и семантических ошибок. Найденные ошибки 

отображаются в окне «Problems», как показано на рисунке 49. 

 
Рисунок 49 — Окно «Problems» ИСР WIDE 2.0 

Кнопки в окне редактирования элементов имеют следующий 

функционал: 

 Add – добавляет элемент (Partition или Server) в таблицу процессов. 

Если ни один элемент не выделен, то новый элемент будет добавлен в 

конец списка. Диалоговое окно для добавления нового элемента 

показано на рисунке 50; 
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Рисунок 50 — Диалоговое окно «Добавить процесс» ИСР WIDE 2.0 

 Remove – удаляет выбранный элемент; 

 Up – перемещает элемент вверх, если это возможно, при этом не 

нарушается установленный порядок элементов; 

 Down – перемещает элемент вниз, если это возможно, при этом не 

нарушается установленный порядок элементов. 

Функциональное окно «Outline» при активном редакторе «BootEditor» в 

ИСР WIDE 2.0 отображает древовидную структуру всего файла с параметрами 

загрузочного образа, как это показано на рисунке 51. Для быстрого перехода к 

требуемому элементу необходимо дважды щелкнуть левой кнопкой мыши по 

соответствующему элементу. 

Страница «boot.xml» соответствует текстовому представлению файла с 

параметрами загрузочного образа. 
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Рисунок 51 — Окно «Outline» ИСР WIDE 2.0 

 4.2.5 Подготовка конфигурационного файла ARINC 653 

 4.2.5.1 Создание конфигурационного файла ARINC 653 

Для создания конфигурационного файла ARINC 653 в уже созданном 

проекте необходимо щелкнуть правой кнопкой мыши по пустому месту в окне 

«Project Explorer» и в появившемся контекстном меню выбрать 

«New→config.xml», как показано на рисунке 52. 

 
Рисунок 52 — Контекстное меню «New→config.xml» ИСР WIDE 2.0 

В открывшемся окне, как показано на рисунке 53, можно изменить 

значения атрибутов. Для этого необходимо снять флаг «Use default 

ARINC_653_Module element». Атрибуты ModuleName, ModuleVersion и 

ModuleId задаются в соответствующих полях. Остальные атрибуты задаются 

в текстовом поле «ARINC_653_Module». 

Мастер осуществляет проверку допустимости вводимых значений. Так, 

в соответствии со стандартом ARINC 653 значения ModuleName и 
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ModuleVersion не должны быть более 30 символов, а значение ModuleId 

должно быть в виде десятичного или шестнадцатеричного числа. 

 
Рисунок 53 — Диалоговое окно «Arinc653 XML Wizard» ИСР WIDE 2.0 

 4.2.5.2 Редактирование основных элементов конфигурационного 

файла ARINC 653 

Для редактирования основных элементов конфигурационного файла 

ARINC 653 необходимо открыть файл config.xml. Редактирование файла 

осуществляется в редакторе «ArincEditor», который содержит страницы: 

«HM System», «HM Module», «HM Partition», «Partition», «Module_Schedule», 

«Connection_Table», «File_System», «LogbookSystem» и «config.xml». 

Страница «HM System» соответствует основному элементу 

«System_HM_Table» конфигурационного файла ARINC 653 и определяет 

уровень ошибки (модуль, раздел, процесс), в зависимости от обнаруженной 

ошибки и состояния системы, как показано на рисунке 54. 
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Рисунок 54 — Страница HM System в ArincEditor ИСР WIDE 2.0 

Реакция на ошибку при выполнении ARINC-раздела определяется 

уровнем ошибки (MODULE, PARTITION, PROCESS), который определяется 

идентификатором ошибки (DEADLINE_MISSED, APPLICATION_ERROR, 

NUMERIC_ERROR, ILLEGAL_REQUEST, MEMORY_VIOLATION, 

HARDWARE_FAULT, POWER_FAIL) и состоянием системы (Kernel, 

Untrusted server, Error Handler, User). 

Для того чтобы определить уровень ошибки, необходимо дважды 

щелкнуть на ячейке соответствующей требуемому состоянию системы и 

обнаруженной ошибке, либо выделить ячейку и нажать клавишу Enter. В 

появившемся окне «Error Details» необходимо указать уровень ошибки 

(MODULE, PARTITION или PROCESS) в поле «Error Level», как показано на 

рисунке 55. 

При выборе ошибки уровня модуля (MODULE) в поле «Error Action» 

необходимо указать реакцию на ошибку (IGNORE, SHUTDOWN или RESET), 

как показано на рисунке 56. 
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Рисунок 55 — Диалоговое окно «Error Details» ИСР WIDE 2.0 

 
Рисунок 56 — Диалоговое окно «Error Details» ИСР WIDE 2.0 

При выборе ошибки уровня раздела (PARTITION) указывается реакция 
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на ошибку (WARM_START, COLD_START, IGNORE или IDLE) для каждого 

раздела, как показано на рисунке 57. 

 
Рисунок 57 — Диалоговое окно «Error Details» ИСР WIDE 2.0 

Если выделить ячейку в таблице, то внизу страницы будет отображена 

информация о реакции на данную ошибку, как показано на рисунке 58. 

Страница «HM Module» соответствует основному элементу 

«Module_HM_Table» конфигурационного файла ARINC 653 и содержит 

реакции на ошибки, соответствующие ошибкам уровня модуля, как показано 

на рисунке 59. Реакцией на ошибку может быть сброс (RESET), отключение 

(SHUTDOWN) и игнорирование (IGNORE). Установить реакцию на ошибку 

можно только для тех состояний, для которых в HM-таблице системы (на 

странице «HM System») указан уровень ошибки MODULE. 
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Рисунок 58 — Страница «HM System» редактора «ArincEditor» ИСР WIDE 

2.0 

 
Рисунок 59 — Страница «HM Module» редактора «ArincEditor» ИСР WIDE 

2.0 

Страница «HM Partition» соответствует основным элементам 

«Partition_HM_Table» конфигурационного файла ARINC 653 и содержит 

действия, соответствующие ошибкам уровня раздела, как показано на 

рисунке 60. Каждому разделу соответствует одна HM-таблица раздела. 

Переключение HM-таблиц разделов осуществляется в поле «Partition» в 

верхнем левом углу страницы. Реакцией на ошибку уровня раздела может 

быть: WARM_START – горячий рестарт, COLD_START – холодный рестарт, 
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IGNORE – игнорировать и IDLE – остановка раздела. Установить реакцию на 

ошибку можно только для тех состояний, для которых в HM-таблице системы 

(на странице «HM System») указан уровень ошибки PARTITION. 

 
Рисунок 60 — Страница «HM Partition» редактора «ArincEditor» ИСР WIDE 

2.0 

Страницы «Module_Schedule», «Connection_Table», «File_System», 

«LogbookSystem» соответствуют одноименным основным элементам 

конфигурационного файла ARINC 653. Страница редактирования элементов в 

редакторе «ArincEditor» разделена на две части, как показано на рисунке 61. 

 
Рисунок 61 — Страница «Module_Schedule» редактора «ArincEditor» 

ИСР WIDE 2.0 

Слева расположено дерево с элементами, справа отображаются поля со 
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значениями атрибутов выбранного элемента. Атрибуты, обязательные для 

заполнения, помечены символом «*», в соответствии со стандартом 

ARINC 653. Для изменения значения атрибута необходимо в 

соответствующем поле ввести новое значение. Если навести указатель мыши 

на название атрибута, то появится описание значения типа этого атрибута, как 

показано на рисунке 62. 

 
Рисунок 62 — Окно редактирования атрибутов в редакторе «ArincEditor» 

ИСР WIDE 2.0 

При вводе ошибочного значения атрибута появится предупреждение о 

некорректном значении атрибута, как показано на рисунке 63. 

 
Рисунок 63 — Окно с отображением некорректного значение атрибута в 

редакторе «ArincEditor» ИСР WIDE 2.0 

Если список возможных значений атрибута определен, то их можно 

выбрать из выпадающего списка, как показано на рисунке 64. 
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Рисунок 64 — Окно выбора значения атрибута из выпадающего списка в 

редакторе «ArincEditor» ИСР WIDE 2.0 

Добавление, перемещение и удаление элементов осуществляется при 

помощи нажатия на кнопки в секции дерева, как показано на рисунке 65, или 

при помощи вызова контекстного меню, как показано на рисунке 66. 

 
Рисунок 65 — Окно редактирования элементов в редакторе «ArincEditor» 

ИСР WIDE 2.0 
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Рисунок 66 — Контекстное меню в дереве элементов редактора «ArincEditor» 

ИСР WIDE 2.0 

Кнопки в окне редактирования элементов имеют следующий 

функционал: 

 Add – добавляет основной элемент после выделенного элемента. Если 

ни один элемент не выделен, то новый элемент будет добавлен в конец 

списка; 

 Remove – удаляет выбранные элементы; 

 Up – перемещает элемент вверх, если это возможно, при этом не 

нарушается установленный порядок элементов; 

 Down – перемещает элемент вниз, если это возможно, при этом не 

нарушается установленный порядок элементов; 

 Comment (Uncomment) – выбранные элементы будут 

закомментированы (раскомментированы). Закомментированные 

элементы выделяются другим цветом. Пункты контекстного меню в 

окне редактирования элементов имеют следующий функционал: 

 New – создает основной или дочерний элемент; 

 Comment – выбранные элементы будут закомментированы 

(раскомментированы). Соответствует кнопке «Comment»; 

 Open XML Declaration – переход на страницу config.xml к выбранному 

тегу. 

Страница «Partition» соответствует основным элементам «Partition» и 
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«Partition_Memory» конфигурационного файла ARINC 653. Страница 

«Partition» содержит атрибуты разделов, определяет потребности разделов в 

памяти, также определяются порты разделов и их атрибуты, как показано на 

рисунке 67. 

 
Рисунок 67 — Страница «Partition» редактора «ArincEditor» ИСР WIDE 2.0 

При добавлении раздела указываются следующие атрибуты: 

идентификатор раздела, имя раздела и размер выделяемой памяти, как 

показано на рисунке 68. При этом создаются элемент Partition и 

соответствующий ему элемент Partition_Memory. 

 
Рисунок 68 — Диалоговое окно «Add new element» ИСР WIDE 2.0 

В правой части страницы «Partition» отображаются связи данного 

раздела с другими разделами и псевдоразделами в таблицах «Source ports» и 

«Destinaion ports». В таблице «Source ports» указаны порты-отправители 

выбранного раздела. В таблице «Destination ports» – порты назначения 
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указанного раздела, как показано на рисунке 69. 

 
Рисунок 69 — Окно «Partition Connections» в редакторе «ArincEditor» 

ИСР WIDE 2.0 

Для того чтобы задать атрибуты канала, необходимо выделить 

требуемый порт и дважды щелкнуть левой кнопкой мыши, либо нажать 

клавишу «Enter». В открывшемся диалоговом окне необходимо указать 

атрибуты канала и определяется раздел (псевдораздел) и порт с которым 

требуется установить соединение, как показано на рисунке 70. 

Кнопка «Create port» позволяет создать новый порт для выбранного 

раздела. Все созданные каналы также отображаются на странице 

Connection_Table. 

Чтобы настроить отображение портов, необходимо нажать на кнопку 

«Фильтр» в правом верхнем углу таблицы «Source ports» или «Destination 

ports». В открывшемся диалоговом окне можно отфильтровать порты по типу 

или разделу с которым установлено соединение, как показано на рисунке 71. 
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Рисунок 70 — Диалоговое окно  «Channel setting» ArincEditor ИСР WIDE 2.0 

 
Рисунок 71 — Диалоговое окно «Применить фильтр» ИСР WIDE 2.0 

Страница «config.xml» соответствует текстовому представлению 

конфигурационного файла ARINC 653. 

При переходе на другую страницу редактора, а также при сохранении 
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документа, ИСР WIDE 2.0 осуществляет проверку конфигурационного файла 

ARINC 653 на предмет синтаксических и семантических ошибок. Найденные 

ошибки отображаются в окне «Problems», как показано на рисунке 72. 

 
Рисунок 72 — Окно «Problems» ИСР WIDE 2.0 

Функциональное окно «Outline» в ИСР WIDE 2.0 отображает 

древовидную структуру всего конфигурационного файла ARINC 653, как 

показано на рисунке 73. Для быстрого перехода к требуемому элементу 

необходимо дважды щелкнуть левой кнопкой мыши по соответствующему 

элементу. 

Для того чтобы перейти к требуемому элементу в текстовом 

представлении, необходимо щелкнуть правой кнопкой мыши по этому 

элементу и в появившемся контекстном меню выбрать «Open XML 

Declaration». 
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Рисунок 73 — Диалоговое окно «Outline» ИСР WIDE 2.0 

 4.2.6 Параметры и запуск сборки проекта интегратора 

Для изменения параметров сборки проекта Интегратора необходимо 

открыть файл «prjdeps.in». Редактирование файла осуществляется в редакторе 

«IntegratorEditor», как показано на рисунке 74. 
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Рисунок 74 — Окно редактора «IntegratorEditor» ИСР WIDE 2.0 

В поле «OS_TARGET» указывается путь до поставочного комплекта 

ОСРВ. 

В поле «CONFIG» указывается путь до конфигурационного файла 

ARINC 653 config.xml. 

В поле «BOOT» указывается путь до файла с параметрами загрузочного 

образа boot.xml. 

В поле «Проекты ФПО» указываются проекты ФПО, которые входят в 

состав проекта Интегратора. Для того, чтобы добавить проект в сборку, 

необходимо нажать на кнопку «Add» в поле «Проекты ФПО» и, в появившемся 

окне, выбрать требуемый проект ФПО, как показано на рисунке 75. 

Добавляемый проект ФПО должен быть расположен в рабочем пространстве 

workspace. 
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Рисунок 75 — Диалоговое окно «Project selection» ИСР WIDE 2.0 

Для того чтобы изменить порядок сборки, необходимо использовать 

кнопки «Up» и «Down». 

В поле «Пути» поиска исполняемых файлов (*.elf) указываются пути до 

каталогов с исполняемыми файлами уже собранных проектов ФПО в формате 

*.elf. Для того чтобы добавить каталог с исполняемыми файлами, необходимо 

нажать на кнопку «Add» в поле «Пути поиска исполняемых файлов» и, в 

открывшемся диалоговом окне, выбрать расположение каталога, как показано 

на рисунке 76. Каталог с исполняемыми файлами может располагаться как в 

рабочем пространстве, так и в не его. 

Редактирование параметров сборки допускается через свойства проекта 

Интегратора. Для того чтобы открыть свойства проекта интегратора, 

необходимо в окне «Project Explorer» щелкнуть правой кнопкой мыши по 

проекту, в открывшемся контекстном меню выбрать «Properties→Проект 

Интегратора», как показано на рисунке 77. 
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Рисунок 76 — Диалоговое окно «Add..» ИСР WIDE 2.0 

 
Рисунок 77 — Диалоговое окно «Properties» ИСР WIDE 2.0 

Для проекта Интегратора доступны следующие варианты сборки: 

«Образ конфигураций», «Образ приложений» и «Собрать всё». 

Сборка «Образ конфигураций» – сборка конфигурации ОСРВ в 

бинарном виде из файлов конфигурации config.xml и boot.xml. Результат 

сборки – файл cfgset.bin. 

Сборка «Образ приложений» – сборка разделов ФПО, библиотек и 

серверов входящих в проект. Результат сборки – файлы формата *.a для 

библиотек и файлы формата *.elf для разделов. 

Сборка «Собрать всё» – полная сборка проекта, включает в себя 
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следующие этапы: 

 сборка конфигурации ОСРВ; 

 сборка разделов ФПО; 

 сборка ядра ОСРВ; 

 создание загружаемого программного модуля. 

Результат сборки – загружаемый образ с расширением *.bin. Для 

успешной сборки проекта необходимо каждый раздел ФПО описать в 

конфигурационном файле ARINC 653 config.xml и добавить в таблицу 

процессов в файл boot.xml. Каждый раздел должен быть указан в поле 

«Проекты ФПО» в «IntegratorEditor», либо этот раздел должен быть уже 

собран, в этом случае указывается путь до каталога с исполняемым файлом 

*.elf в поле «Пути поиска исполняемых файлов (*.elf)». 

Для запуска сборки проекта в окне «Project Explorer» необходимо 

щелкнуть правой кнопкой мыши по проекту и, в появившемся контекстном 

меню, выбрать «Build Project» (конфигурация сборки по умолчанию – 

«Собрать всё»). Для запуска другой конфигурации сборки необходимо 

щелкнуть правой кнопкой мыши по проекту и, в появившемся контекстном 

меню, выбрать Build Configurations→Set Active→«Название сборки», как 

показано на рисунке 78. 

Выбор конфигурации сборки и запуск сборки доступен на панеле 

инструментов. Для запуска последней конфигурации сборки, необходимо 

нажать на кнопку «build» на панели инструментов. Для выбора конфигурации 

сборки и ее запуска, необходимо выбрать требуемую конфигурацию сборки в 

меню рядом с кнопкой «build», как показано на рисунке 79. 

Сборка проекта осуществляется в каталог build, который расположен в 

рабочем пространстве workspace и отображается в окне «Project Explorer», как 

показано на рисунке 80. 
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Рисунок 78 — Вызов команды «Build Configurations→Set Active» из 

контекстного меню ИСР WIDE 2.0 

 
Рисунок 79 — Кнопка «Build» на панели инструментов ИСР WIDE 2.0 

 
Рисунок 80 — Отображение каталога build в окне «Project Explorer» 

ИСР WIDE 2.0 

Если каталог build не отображается в окне «Project Explorer», то, как 

показано на рисунке 81, необходимо нажать на кнопку «Show build» на панели 
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инструментов главного окна ИСР WIDE 2.0. 

 
Рисунок 81 — Кнопка «Show build» на панели инструментов ИСР WIDE 2.0 

Для того, чтобы очистить каталог build, необходимо, как показано на 

рисунке 82, нажать на кнопку «Clean build» на панели инструментов главного 

окна ИСР WIDE 2.0. 

После сборки проекта требуется обновить каталог build, для этого 

необходимо открыть каталог build в окне «Project Explorer» и нажать на 

клавиатуре клавишу F5. 

 
Рисунок 82 — Кнопка «Clean build» на панели инструментов ИСР WIDE 2.0 

 4.3 Объединенный проект 

 4.3.1 Структура объединенного проекта 

Объединенный проект представляет собой объединение проекта 

Интегратора и входящих в него проектов ФПО, т.е. проекты ФПО 

располагаются не в рабочем пространстве workspace, а внутри одного проекта 

в каталоге src. 

Объединенный проект имеет следующую структуру: 

 make-файлы проекта – Makefile и appset.mk; 

 файл со списком каталогов с исходным кодом, участвующих в 

сборке – prjdeps.in; 

 конфигурационный файл ARINC 653 – config.xml; 

 файл с параметрами загрузочного образа – boot.xml; 

 каталог src, содержащий файлы с исходным кодом. 
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Пример содержимого проекта в окне «Project Explorer» показан на 

рисунке 83. 

 
Рисунок 83 — Отображение примера объединенного проекта в окне «Project 

Explorer» ИСР WIDE 2.0 

Make-файлы проекта, файл prjdeps.in и конфигурационный файлы 

объединенного проекта имеют такую же структуру и параметры, что и файлы 

в проекте Интегратора (см. п. 4.2.1). 

В каталоге src располагаются каталоги, в которых содержатся файлы с 

исходным кодом разделов, библиотек и серверов. Каждый каталог 

соответствует одному разделу, библиотеке или серверу и имеет структуру 

аналогичную с проектом ФПО (см. п. 4.1.1). 

В отличие от проекта Интегратора объединенных проектов может быть 

несколько в одном рабочем пространстве workspace. 



СПО. Руководство программиста ФПО. ИСР WIDE 2.0 

ВАШП.501120.101 strix-guide:WIDE@v1.0.1 Стр. 78 из 113 
 

 4.3.2 Создание объединенного проекта 

Для создания объединенного проекта требуется выполнить следующие 

действия: 

 в главном меню ИСР WIDE 2.0 выбрать «File→New→Project»; 

 в появившемся диалоговом окне «New», в категории «ОСРВ» выбрать 

подпункт «Объединенный», как показано на рисунке 84, и нажать 

кнопку «Next»; 

 
Рисунок 84 — Диалоговое окна «New» ИСР WIDE 2.0 

 в открывшемся окне «Новый проект ОСРВ», как показано на 

рисунке 85, в поле «Project name» указать имя создаваемого проекта. В 

поле «OS_TARGET» указать путь до поставочного комплекта ОСРВ и 

нажать кнопку «Finish». 
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Рисунок 85 — Диалоговое окно «Новый проект ОСРВ» ИСР WIDE 2.0 

 4.3.3 Импорт объединенного проекта 

Для того, чтобы импортировать готовый объединенный проект, 

необходимо выполнить следующие действия: 

 щелкнуть правой кнопкой мыши в окне «Project Explorer» ИСР WIDE 

2.0 и в появившемся контекстном меню выбрать «Import»; 

 в открывшемся диалоговом окне, в категории «ОСРВ» выбрать 

«Объединенный», как показано на рисунке 86, и нажать кнопку «Next»; 

 в открывшемся диалоговом окне «Импорт проекта ОСРВ», как 

показано на рисунке 87, в поле «Project location:» нажать кнопку 

«Browse...» и выбрать путь до импортируемого проекта. При 

необходимости изменить путь до поставочного комплекта ОСРВ – 

нажать кнопку «Browse...» в поле «OS_TARGET:» и выбрать путь, после 

чего нажать кнопку «Finish». 
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Рисунок 86 — Диалоговое окно «Import» ИСР WIDE 2.0 

 
Рисунок 87 — Диалоговое окно «Import» ИСР WIDE 2.0 
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 4.3.4 Параметры и запуск сборки объединенного проекта 

Параметры сборки объединенного проекта соответствуют параметрам 

сборки проекта Интегратора. Для изменения параметров сборки 

объединенного проекта необходимо открыть файл prjdeps.in. Редактирование 

файла осуществляется в редакторе «IntegratorEditor», как показано на 

рисунке 88. 

 
Рисунок 88 — Окно редактора «IntegratorEditor» ИСР WIDE 2.0 

В поле OS_TARGET указывается путь до поставочного комплекта 

ОСРВ. 

В поле CONFIG указывается путь до конфигурационного файла 

ARINC 653 – config.xml. 

В поле BOOT указывается путь до файла с параметрами загрузочного 

образа – boot.xml. 

В поле «Пути поиска исполняемых файлов (*.elf):» указываются пути до 

каталогов с исполняемыми файлами уже собранных проектов ФПО в формате 

*.elf. 

В поле «Проекты ФПО» указываются каталоги с исходным кодом 

разделов, библиотек и серверов, которые входят в состав объединенного 

проекта. В отличие от проекта Интегратора, где указываются проекты ФПО 
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расположенные в рабочем пространстве workspace, в объединенном проекте 

указываются каталоги расположенные в каталоге src. 

Редактирование параметров сборки допускается через свойства 

объединенного проекта. Для того чтобы открыть свойства объединенного 

проекта, необходимо в окне «Project Explorer» щелкнуть правой кнопкой 

мыши по проекту, в открывшемся контекстном меню выбрать 

«Properties→Проект ОСРВ», как показано на рисунке 89. 

 
Рисунок 89 — Диалоговое окно «Properties» ИСР WIDE 2.0 

Для изменения параметров сборки отдельного раздела, библиотеки или 

сервера, входящего в состав объединенного проекта, необходимо открыть 

файл Makefile в каталоге, соответствующем этому разделу, библиотеке или 

серверу, параметры соответствуют параметрам сборки проекта ФПО 

(см. п. 4.1.4). Редактирование файла осуществляется в редакторе «FpoEditor», 

как показано на рисунке 90. 
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Рисунок 90 — Окно редактора «Fpo Editor» ИСР WIDE 2.0 

В поле «Libraries» добавляются или удаляются библиотеки, 

необходимые для сборки раздела, библиотеки или сервера. 

В поле «Исходный код» указываются файлы, участвующие в сборке. 

В поле «Флаги компилятора» задается значение дополнительных флагов 

сборки для компилятора. 

Редактирование make-файла допускается через свойства каталога с 

исходным кодом раздела, библиотеки или сервера. Для того, чтобы открыть 

свойства каталога, необходимо в окне «Project Explorer» щелкнуть правой 

кнопкой мыши по каталогу с исходным кодом, в открывшемся контекстном 

меню выбрать «Properties → Проект ФПО», как показано на рисунке 91. 

Для объединенного проекта доступны те же конфигурации сборки, что 

и для проекта Интегратора: «Образ приложений», «Образ конфигураций», 

«Собрать всё» (см. п. 4.2.6). 

Сборка осуществляется в каталог build, расположенный внутри 

объединенного проекта. 
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Рисунок 91 — Диалоговое окно «Properties» ИСР WIDE 2.0 

В Приложении Б приведен пример создания проекта ФПО и открытия 

готового примера проекта. 
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 5 Отладка ПО 

 5.1 Стенд для отладки ПО 

ОСРВ позволяет производить удаленную отладку процессов. Отладка 

производится с помощью стандартного отладчика GDB. 

Доступны следующие возможности: 

 подключение отладчика к работающему процессу; 

 работа с многопоточными процессами; 

 модификация памяти и регистров процесса; 

 пошаговое исполнение кода; 

 установка точек останова (breakpoint); 

 установка точек контроля доступа к памяти (memory watchpoint). 

Предусматривается возможность установки максимум четырех точек 

контроля доступа к памяти со срабатыванием на чтение, запись или 

чтение/запись. Разрешено устанавливать точки только для контроля доступа к 

сегменту данных. 

Подключение отладчика к платформе производится через 

последовательный порт или TCP/IP. При подключении отладчика через 

последовательный порт передача данных осуществляется через прокси-сервер 

последовательных портов Ser2net по протоколу telnet. Если есть 

необходимость в отключении оптимизации кода, то для этого в make-файле 

программы необходимо задать параметр CFLAGS='-O0'. Подготовленный к 

отладке проект запускается на платформе. 

Структурная схема стенда для отладки проекта ФПО на аппаратной 

платформе при подключении отладчика через последовательный порт 

представлена на рисунке 92. 
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Рисунок 92 — Структурная схема стенда для отладки программ 

(подключение отладчика через последовательный порт) 

Стенд для отладки включает в себя следующие основные компоненты: 

1) ПК под управлением операционной системы Ubuntu 16.04, на которой 

установлены программные средства разработки и отладки ПО, а также 

прокси-сервер последовательных портов Ser2net; 

2) вычислительная платформа, на которой запускается подготовленный 

для отладки проект; 

3) два соединительных кабеля USB − COM; 

Для отображения данных, выводимых ПО через последовательный порт 

отладочной платы, на ПК функционирует прокси-сервер последовательных 

портов Ser2net, выполняющий вывод на экран данных, поступающих через 

соединительный кабель USB − COM. Подключение отладчика к платформе 

производится по второму последовательному порту на скорости 115200 бод. 

4) соединительный кабель Ethernet − Ethernet. 

Канал связи Ethernet предоставляет технологический канал связи, 

который позволяет передавать файл загружаемого образа в оперативную 

память платформы. 

Для настройки прокси-сервера последовательных портов Ser2net 

необходимо открыть файл конфигурации ser2net.conf, выполнив команду 

sudo gedit /etc/ser2net.conf , 

где /etc/ser2net.conf − путь к файлу конфигурации прокси-сервера 

последовательных портов Ser2net. 

В открывшемся текстовом документе добавить строку 
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2002:telnet:0:/dev/ttyUSB1:115200, LOCAL 8DATABITS NONE 1STOPBIT banner, 

где 2002 – номер порта, который будет использоваться для отладки; 

/dev/ttyUSB1 – имя порта USB к которому подключен соединительный 

кабель USB − COM. 

После настройки необходимо перезапустить прокси-сервер 

последовательных портов Ser2net командой 

sudo service ser2net restart. 

При подключении отладчика через Ethernet требуется только один 

соединительный кабель USB − COM для передачи данных. Через канал связи 

Ethernet осуществляется передача загружаемого образа в оперативную память 

платформу и подключение отладчика к платформе. 

 5.2 Сборка для отладки ПО 

Для отладки ПО процессов необходимо добавить в таблицу процессов 

проекта в файле boot.xml сервер GDB. Для этого необходимо выполнить 

следующие действия: 

1) открыть файл boot.xml, дважды щелкнув по нему левой кнопкой 

мыши, в окне «Project Explorer». Файл будет открыт в редакторе «BootEditor»; 

2) перейти на вкладку «Таблица процессов» и нажать кнопку «Add». 

В открывшемся диалоговом окне заполнить поля для сервера GDB, как 

показано на рисунке 93, со следующими значениями атрибутов, после чего 

нажать кнопку «OK»; 

3) в таблице процессов выбрать созданный сервер GDB и в поле 

«Переменные окружения» нажать на кнопу «ADD», как показано на 

рисунке 94; 
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Рисунок 93 — Диалоговое окно «Добавить процесс» ИСР WIDE 2.0 

 
Рисунок 94 — Окно «Переменные окружения» ИСР WIDE 2.0 

4) в открывшемся диалоговом окне «Add variable» задать для 

переменной TYPE значение UDP – при подключении к отладчику через 

Ethernet и SERIAL при подключении к отладчику через последовательный 

порт, и нажать на кнопку «ОК», как показано на рисунке 95. При 

необходимости указывается номер порта (переменная PORT), по умолчанию 

используется значение 1 при подключении через последовательный порт, и 

значение 1011 при подключении через Ethernet. 
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Рисунок 95 — Диалоговое окно «Add variable» ИСР WIDE 2.0 

При отладке ПО через Ethernet должен быть настроен соответствующий 

сервер поддержки интерфейса Ethernet. Также независимо от используемого 

при отладке ПО интерфейса должен быть настроен сервер GDB. 

Конфигурация серверов приведена в документе "Руководство программиста 

ФПО. Работа с ПО" соответствующего проекта. 

Для эффективной отладки ПО проект должен быть собран с 

добавлением отладочной информации. Отладочная информация, сохраняемая 

в выполняемых файлах, содержит описание переменных, функций, макросов, 

соответствия между номерами строк исходного текста и адресами в 

выполняемом коде, а также другие данные, используемые для отладки. 

Для того, чтобы C-компилятор GCC (GNU Compiler Collection) поместил 

в выполняемые файлы отладочную информацию, его необходимо указать флаг 

компиляции -g или -ggdb (при указании флага -ggdb будет добавлена 

расширенная отладочная информация) для отлаживаемого процесса. 

Для того, чтобы указать флаг -g, необходимо открыть make-файл 

отлаживаемого раздела в FpoEditor, и добавить флаг -g (или -ggdb) в поле 

«Флаги, компилятора», как показано на рисунке 96. 

В сочетании с опцией -g (-ggdb) рекомендуется использовать опцию 

отключения оптимизации -O0. При отладке оптимизированного кода порядок 

выполнения может не соответствовать исходному тексту программы. 
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Рисунок 96 — Редактор FpoEditor ИСР WIDE 2.0 

 5.3 Использование интегрированной среды разработки для 

отладки ПО 

ИСР WIDE 2.0 предоставляет средства для отладки программ, 

работающих на целевой платформе, на уровне исходного кода. Подключение 

отладчика к платформе производится через TCP/IP. Для соединения отладчика 

и программы, запущенной на целевой платформе, необходимо выполнить 

следующие действия: 

1) в главном меню ИСР WIDE 2.0 выбрать «Run→Debug 

Configurations...»; 

2) в появившемся окне выбрать пункт «ОСРВ» и нажать кнопку 

«New launch configuration» или дважды щелкнуть левой кнопкой мыши по 

пункту «ОСРВ»; 

3) в открывшемся окне выбрать созданный подпункт пункта «ОСРВ», 

как показано на рисунке 97; 

4) в поле Project выбрать проект, который содержит отлаживаемый 

раздел ПО, в поле «С/С++ Application» выбрать отлаживаемый раздел ПО, 

либо указать путь к elf-файлу, который будет использован для отладки. В поле 

«Connect to process:» указать номер отлаживаемого процесса либо его 

название; 
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5) в поле «Connection» необходимо указать настройки соединения. 

В поле Type выбрать TCP. Для соединения по Ethernet необходимо указать 

адрес целевой машины и номер порта. Адрес должен совпадать с адресом, 

указанным в переменных окружения, сервера ETH0. Адрес должен начинаться 

с приставки «udp:». Номер порта должен совпадать с указанным в настройках 

сервера GDB. Если номер порта не указан в настройках сервера GDB, то 

используется значение по умолчанию – 1011. При подключении по 

последовательному порту – порт по умолчанию – 1; 

 
Рисунок 97 — Диалоговое окно «Debug Configuration» ИСР WIDE 2.0 

6) для переключения в режим отладки необходимо в главном меню 

ИСР WIDE 2.0 выбрать «Window→Perspective→Open Perspective→Debug» 

или нажать на кнопку компоновки «Debug», расположенной среди 

компоновочных кнопок справа от панели инструментов; 

7) для запуска процесса отладки в главном меню ИСР WIDE 2.0 нажать 

кнопки «Run→Debug Configurations...», после чего выбрать требуемую 

конфигурацию и нажать кнопку «Debug». Конфигурация задается нажатием 

кнопки на панели инструментов, расположенной между кнопками «debug» и 

«run». При задании конфигурации производится и запуск отладчика. При 
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заданной конфигурации отладчик можно запустить и кнопкой «debug» на 

панели инструментов; 

8) для завершения процесса отладки в главном меню ИСР WIDE 2.0 

нажать кнопки «Run→Disconnect». 

9) При настройке конфигурации отладки программы elf-файл и номер 

процесса можно не указывать. В этом случае для подключения к 

отлаживаемой программе необходимо после запуска процесса отладки 

щелкнуть правой кнопкой мыши по созданной конфигурации и выбрать пункт 

«Connect». В появившемся окне указать номер отлаживаемого процесса и имя 

elf-файла. 

Программа, запущенная на целевой платформе, будет приостановлена 

после подключения к ней отладчика. На экране появится диалоговое окно, как 

показано на рисунке 98, предлагающее переключить компоновку из текущей 

в компоновку «Debug». 

 
Рисунок 98 — Диалоговое окно «Confirm Perspective Switch» ИСР WIDE 2.0 

Доступ к отладочной информации предоставляется в следующих 

функциональных окнах: 

1) окно «Debug» предоставляет информацию о процессах и стеке 

вызовов запущенной программы, как показано на рисунке 99; 
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Рисунок 99 — Окно «Debug» ИСР WIDE 2.0 

2) окно «Variables» содержит список переменных, задействованных в 

текущей точке останова, как показано на рисунке 100. Данное окно является 

наиболее важным в процессе отладки, так как оно производит мониторинг 

переменных на каждой точке останова; 

 
Рисунок 100 — Окно «Variables» ИСР WIDE 2.0 

3) окно «Breakpoints» содержит список точек останова, которые 

установил разработчик, как показано на рисунке 101; 

4) редактор исходного кода предоставляет доступ к таблице символов, 

как показано на рисунке 102. 

Для того, чтобы установить точку останова, необходимо дважды 

щелкнуть левой кнопкой мыши в окне редактора исходного кода слева от 

строки, где планируется останов программы. Маркер точки останова показан 

на рисунке 102. 
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Рисунок 101 — Окно «Breakpoints» ИСР WIDE 2.0 

 
Рисунок 102 — Окно редактора исходного кода ИСР WIDE 2.0 

Для того, чтобы продолжить выполнение программы после останова, 

необходимо нажать кнопку «Resume» или клавишу F8. 

Пошаговое выполнение программы осуществляется при помощи кнопок 

на панели инструментов, как показано на рисунке 103: 

1) кнопка «Step into» − пошаговое выполнение программы с заходом в 

вызываемые функции; 

2) кнопка «Step over» − пошаговое выполнение программы с пропуском 

вызываемых функций; 

3) кнопка «Step return» − выполнение программы до конца текущей 

функции. 
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Рисунок 103 — Панель инструментов ИСР WIDE 2.0 с изображением кнопок, 

при помощи которых осуществляется пошаговое выполнение программы 

ИСР WIDE 2.0 предоставляет возможность отладки в режиме 

командной строки. Ввод команд осуществляется в окне «Debugger Console», 

как показано на рисунке 104. Перечень и описание команд приведены в 

документе "Руководство программиста ФПО. Работа с ПО" соответствующего 

проекта. 

 
Рисунок 104 — Диалоговое окно «Debugger Console» ИСР WIDE 2.0  



СПО. Руководство программиста ФПО. ИСР WIDE 2.0 

ВАШП.501120.101 strix-guide:WIDE@v1.0.1 Стр. 96 из 113 
 

Перечень использованных источников 

[1] ARINC Specification 653, Avionics Application Software Standard 

Interface. Part 1 – required services, published: november 15, 2010; 

[2] Matloff, Norman S. The art of debugging with GDB, DDD, and Eclipse – 

San Francisco, USA 2008. – 264 с. ISBN-10 1-59327-002-X; 

[3] Richard S., Roland P., Stan S. Debugging with GDB: The GNU Source-

Level Debugger – Boston, USA 2004. – 519 c.. ISBN 1-882114-77-9. 

  



СПО. Руководство программиста ФПО. ИСР WIDE 2.0 

ВАШП.501120.101 strix-guide:WIDE@v1.0.1 Стр. 97 из 113 
 

Приложение А 

Перечень горячих клавиш интегрированной среды разработки WIDE 2.0 

Перечень горячих клавиш ИСР WIDE 2.0 приведен в таблице А.1. 

Таблица А.1 — Горячие клавиши ИСР WIDE 2.0 

Команда Описание 
Горячие 

клавиши 

Show 

Contextual 

Help 

Открыть внутреннее окно справки Ctrl+F1 

Rename Переименовать выбранный файл (каталог) F2 

Open 

Declaration 

Открыть объявление выбранного объекта (переменная, 

функция и т.д.) 
F3 

Open Type 

Hierarchy 
Открыть выбранный элемент в окне «Type Hierarchy» F4 

Refresh Обновить выбранные ресурсы (файлы, каталоги, проекты) F5 

Debug Повторить последний запуск в режиме отладки F11 

Activate Editor Активировать текущий редактор F12 

Select All 
Выбрать весь текст или все объекты в активном окне или 

редакторе 
Ctrl+A 

Build All Собрать все проекты в рабочем пространстве Ctrl+B 

Copy Скопировать выбранный объект в буфер обмена Ctrl+C 

Find / 

Replace... 
Открыть диалоговое окно «Find/Replace» (найти / заменить) Ctrl+F 

Search... Открыть диалог для поиска в текущем редакторе Ctrl+H 

Incremental 

Find Next 
Инкрементальный поиск, начиная с позиции курсора Ctrl+J 

Find Next Найти следующее искомое выражение в активном редакторе Ctrl+K 
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Команда Описание 
Горячие 

клавиши 

Go to Line Перейти к строке с указанным номером Ctrl+L 

Navigation Развернуть во весь экран активное окно или редактор Ctrl+M 

Quick Outline Отобразить окно «Outline» для активного редактора Ctrl+O 

Print Напечатать содержимое активного редактора Ctrl+P 

Last Edit 

Location 
Перейти к последнему редактированному элементу Ctrl+Q 

Save Сохранить содержимое активного редактора Ctrl+S 

Paste Вставить текст или объект из буфера обмена Ctrl+V 

Close Закрыть активный редактор Ctrl+W 

Cut Поместить текст или выбранный объект в буфер обмена Ctrl+X 

Redo Повторить ранее отмененное действие в активном редакторе Ctrl+Y 

Undo 
Отменить последнее выполненное действие в активном 

редакторе 
Ctrl+Z 

Next Editor 
Активировать следующий открытый редактор, указанный в 

списке наиболее часто используемых редакторов 
Ctrl+F6 

Next View 
Активировать следующее открытое окно, указанное в 

списке наиболее часто используемых окон 
Ctrl+F7 

Next 

Perspective 

Активировать следующую открытую компоновку, 

указанную в списке наиболее часто используемых 

компоновок 

Ctrl+F8 

Next [...] 
Перейти к следующему элементу в активном окне. Название 

команды зависит от активного окна 
Ctrl+. 

Previous 
Перейти к предыдущему элементу в активном окне. 

Название команды зависит от активного окна 
Ctrl+, 
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Команда Описание 
Горячие 

клавиши 

Toggle 

Breakpoint 
Установить точку останова Ctrl+Shift+B 

Switch to 

Editor... 

Открыть диалоговое окно, в котором можно переключиться 

в другой открытый редактор 
Ctrl+Shift+E 

Open Type in 

Hierarchy... 

Открыть диалоговое окно «Open Type in Hierarchy», чтобы 

найти элемент для отображения в окне «Type Hierarchy» 
Ctrl+Shift+H 

Incremental 

Find Previous 
Инкрементальный поиск до позиции курсора Ctrl+Shift+J 

Find Previous 
Найти предыдущее искомое выражение в активном 

редакторе 
Ctrl+Shift+K 

Add Include Добавить Include конструкцию для выбранного элемента Ctrl+Shift+N 

Open 

Resource... 
Открыть диалоговое окно «Open Resource» Ctrl+Shift+R 

Save All Сохранить содержимое всех открытых редакторов Ctrl+Shift+S 

Open 

Element... 

Открыть диалоговое окно «Open Element» для поиска 

необходимого элемента 
Ctrl+Shift+T 

Close All Закрыть все открытые редакторы Ctrl+Shift+W 

Previous Editor 
Активировать предыдущий открытый редактор, указанный 

в списке наиболее часто используемых редакторов 
Ctrl+Shift+F6 

Previous View 
Активировать предыдущее открытое окно, указанное в 

списке наиболее часто используемых окон 
Ctrl+Shift+F7 

Previous 

Perspective 

Активировать предыдущую открытую компоновку, 

указанную в списке наиболее часто используемых 

компоновок 

Ctrl+Shift+F8 

Open Call 

Hierarchy 
Открыть выбранный элемент в окне «Call Hierarchy» Ctrl+Alt+H 

Open Include 
Открыть выбранный файл в окне «Include Browser» Ctrl+Alt+I 



СПО. Руководство программиста ФПО. ИСР WIDE 2.0 

ВАШП.501120.101 strix-guide:WIDE@v1.0.1 Стр. 100 из 113 
 

Команда Описание 
Горячие 

клавиши 

Browser 

Back 
Перейти назад к выбранному элементу из истории в 

подменю 
Alt+Left 

Forward 
Перейти вперед к выбранному элементу из истории в 

подменю 
Alt+Right 

Properties Открыть окно Properties (свойства) для выбранного ресурса Alt+Enter 

Rename... 

Переименовать выбранный объект (переменная, функция и 

т.д.). Изменения распространяются и на другие файлы 

проекта 

Alt+Shift+R 

Shift Left Уменьшает отступ в выбранных строках Shift+Tab 

Примечание – Горячие клавиши работают только при включенной 

английской раскладке клавиатуры. Настройка использования горячих клавиш 

для русской раскладки клавиатуры производится в окне 

«Window→Preferences→General→Keys». Для этого необходимо выбрать 

требуемую команду и нажать на кнопку «Copy Command», чтобы скопировать 

команду, и в поле «Binding» указать требуемую комбинацию клавиш на 

русском языке, как показано на рисунке А.1. 
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Рисунок А.1 — Диалоговое окна «Preferences» ИСР WIDE 2.0 
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Приложение Б 

Пример создания проекта ФПО 

 Б.1 Примеры проектов 

Для того, чтобы создать пример готового проекта необходимо 

выполнить следующие действия: 

1) В главном меню ИСР WIDE 2.0 выбрать «File→New→Project». 

2) В появившемся диалоговом окне «New» в категории «ОСРВ» выбрать 

подпункт «Examples», как показано на рисунке Б.1, и нажать кнопку «Next». 

 
Рисунок Б.1 — Диалоговое окно «New» ИСР WIDE 2.0 

3) В открывшемся окне «Example project» в поле «OS_TARGET» указать 

путь до поставочного комплекта ОСРВ. Выбрать пример и тип проекта, после 

чего нажать кнопку «Finish», как показано на рисунке Б.2. 
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Рисунок Б.2 — Диалоговое окно «Example project» ИСР WIDE 2.0 

В результате будет создан проект указанного типа. Если был выбран 

«Интегратор», будет создан проект Интегратора и необходимые для него 

проекты ФПО. Если в рабочем пространстве workspace уже был проект 

Интегратора, то можно выбрать только объединенный тип проекта. Доступны 

следующие готовые проекты: 

 hello_world – простейший пример с одним разделом; 

 four_partitions – пример с четырьмя разделами; 

 sending_mes – пример коммуникации между разделами; 

 library_example – пример использования библиотеки. 

 Б.2 Создание проекта 

Для создание проекта «Hello World» требуется выполнить следующие 

действия: 

1) В главном меню ИСР WIDE 2.0 выбрать «File→New→Project». 

2) В появившемся диалоговом окне «New» в категории «ОСРВ» выбрать 

подпункт «Объединенный», как показано на рисунке Б.3, и нажать кнопку 



СПО. Руководство программиста ФПО. ИСР WIDE 2.0 

ВАШП.501120.101 strix-guide:WIDE@v1.0.1 Стр. 104 из 113 
 

«Next». 

 
Рисунок Б.3 — Диалоговое окно «New» ИСР WIDE 2.0 

3) В открывшемся диалоговом окне «Новый проект ОСРВ» в поле 

«Project name» ввести название проекта, как показано на рисунке Б.4. В поле 

«OS_TARGET» указать путь до поставочного комплекта ОСРВ, например 

home/user/os-target, после чего нажать кнопку «Finish». 

Для подготовки конфигурационного файла ARINC 653 необходимо 

выполнить следующие действия: 

1) Открыть файл config.xml, дважды щелкнув по нему левой кнопкой 

мыши в окне «Project Explorer». Файл будет открыт в редакторе «ArincEditor». 

2) Перейти на вкладку «Partition», как показано на рисунке Б.5, и нажать 

кнопку «Add». 
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Рисунок Б.4 — Диалоговое окно «Новый проект ОСРВ» ИСР WIDE 2.0 

 
Рисунок Б.5 — Диалоговое окно «Add new element» ИСР WIDE 2.0 

3) В открывшемся окне заполнить поля со следующими значениями 

атрибутов: 

 PartitionIdentifier* − 1; 

 PartitionName* − part1; 

 SizeBytes* - 0x200000 
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4) Перейти на вкладку «Module_Schedule» и нажать кнопку «Add». В 

появившемся диалоговом окне установить в поле «MajorFrameSeconds» 

значение 0.200 и нажать на кнопку «ОК», как показано на рисунке Б.6. 

 
Рисунок Б.6 — Диалоговое окно «Add new element» ИСР WIDE 2.0 

5) Щелкнуть правой кнопкой мыши по элементу Module_Schedule и в 

появившемся контекстном меню выбрать команду «New→Partition_Schedule». 

В появившемся диалоговом окне «Add new element», как показано на 

рисунке Б.7, заполнить поля со следующими значениями атрибутов: 

 PartitionIdentifier* − 1; 

 PartitionName* − part1; 

 PeriodSeconds* − 0.200; 

 PeriodDurationSeconds* − 0.200. 
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Рисунок Б.7 — Диалоговое окно «Add new element» ИСР WIDE 2.0 

6) Щелкнуть правой кнопкой мыши по элементу Partition_Schedule и в 

появившемся контекстном меню выбрать команду «New→Window_Schedule». 

В появившемся диалоговом окне «Add new element», как показано на 

рисунке Б.8, заполнить поля со следующими значениями атрибутов: 

 WindoWIDE 2.0ntifier* − 101; 

 WindowStartSeconds* − 0.0; 

 WindowDurationSeconds* − 0.200; 

 PartitionPeriodStart* − true. 
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Рисунок Б.8 — Диалоговое окно «Add new element» ИСР WIDE 2.0 

7) В главном меню ИСР WIDE 2.0 выполнить команду «File→Save». 

Для подготовки файла с параметрами загрузочного образа boot.xml 

необходимо выполнить следующие действия: 

1) Открыть файл boot.xml, дважды щелкнув по нему левой кнопкой 

мыши в окне «Project Explorer». Файл будет открыт в редакторе «BootEditor». 

2) Перейти на вкладку «Таблица процессов» и нажать кнопку «Add». В 

открывшемся диалоговом окне заполнить поля для сервера APM, как показано 

на рисунке Б.9, со следующими значениями атрибутов, после чего нажать 

кнопку «OK»: 

 Server; 

 Name – APM; 

 Type – TRUSTED; 

 Binary – apm.elf; 

 HeapBytes – 0x400000. 
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Рисунок Б.9 — Диалоговое окно «Добавить процесс» ИСР WIDE 2.0 

3) Нажать повторно кнопку «Add» и заполнить поля для раздела part1 со 

следующими значениями атрибутов, как показано на рисунке Б.10, после чего 

нажать кнопку «OK»: 

 Partition; 

 PartitionIdentifier – 1; 

 PartitionName – part1; 

 Interface – APEX; 

 Binary – partition1.elf. 
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Рисунок Б.10 — Диалоговое окно «Добавить процесс» ИСР WIDE 2.0 

Для создания раздела необходимо выполнить следующие действия: 

1) В окне «Project Explorer» щелкнуть правой кнопкой мыши по каталогу 

src, как показано на рисунке Б.11, и в появившемся контекстном меню выбрать 

«New→Partition». 

 
Рисунок Б.11 — Диалоговое окно «Project Explorer» ИСР WIDE 2.0 

2) В открывшемся диалоговом окне в поле «Partition name» ввести имя 

раздела, в поле «Language» выбрать язык разработки ФПО − Си или Ада, как 

показано на рисунке Б.12, и нажать кнопку «ОК». 
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Рисунок Б.12 — Диалоговое окно «Create new folder» ИСР WIDE 2.0 

3) В окне «Project Explorer» щелкнуть правой кнопкой мыши по 

созданному разделу, как показано на рисунке Б.13, и в появившемся 

контекстном меню выбрать команду «New→File». 

 
Рисунок Б.13 — Диалоговое окно «Project Explorer» ИСР WIDE 2.0 

4) В открывшемся диалоговом окне ввести имя файла main.c, как 

показано на рисунке Б.14, и нажать кнопку «Finish». Файл main.c откроется в 

редакторе «С/С++ Editor». 
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Рисунок Б.14 — Диалоговое окно «New file» ИСР WIDE 2.0 

5) В файл main.c, как показано на рисунке Б.15, добавить следующие 

строки: 

#include <apex/partition.h> 

#include <apex/time.h> 

void main( void ) { 

    RETURN_CODE_TYPE ret; 

    SET_PARTITION_MODE( NORMAL, &ret ); 

    while ( 1 ) { 

        sys_printf("Hello world\n"); 

        TIMED_WAIT(APEX_NANO, &ret ); 

    }} 

Примечание – Функция SET_PARTITION_MODE устанавливает режим 

[NORMAL] для раздела. Функция TIMED_WAIT приостанавливает 

выполнение процесса. 

Для сборки проекта ФПО требуется в окне «Project Explorer» щелкнуть 

правой кнопкой мыши на строке, соответствующей созданному проекту, и в 
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появившемся контекстном меню выбрать «Build Project». 

 
Рисунок Б.15 — Окно «С/С++ Editor» ИСР WIDE 2.0 

 


